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Overview 
Amicus Attorney Advanced and Client/Server Edition users can 
integrate their data with QuickBooks. This dynamic link saves time and 
ensures consistency by not requiring data to be entered more than 
once. You can easily exchange File/Client information with 
Customer/Job information, File/Job Types, and Vendors. You can map 
Amicus Attorney Team Members to QuickBooks Employees, and take 
advantage of QuickBooks Class Lists. The link ensures that Amicus 
Attorney Activities and Billing Rates are available in QuickBooks. Once 
QuickBooks is installed on workstations from which Time Entries will be 
posted and the data-sharing feature is set up, those Team Members 
may post directly from Amicus Attorney. 

Unlike the manual import/export template solution previously available 
in Amicus Attorney, this link sends Time Entries to QuickBooks as Time 
Entries and not as Invoices or Statements. It is essential that you 
follow the steps detailed to ensure a smooth flow of information 
between the two programs.  

What you need 
You will require the following to use the link: 

• Amicus Attorney version 5.0.2 with QuickBooks patch or higher 
(Advanced Edition or Client/Server Edition only)  

• QuickBooks 2002, 2003, or 2004 (U.S. Pro Edition or U.S. Premier 
Edition only) 

Important: QuickBooks must be installed on the same computer as 
Amicus Administrator as well as each Team Member workstation that 
wishes to post Time Entries. Those Team Members should possess File 
system rights to read and write to the QuickBooks Company file. 
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What is Exchanged? 
The link handles the dynamic exchange of several record types within 
the two programs. Some types of records are exchanged in both 
directions, while others are only sent from Amicus Attorney to 
QuickBooks. The following table illustrates the types of data 
exchanged and the direction of the Exchange: 

 
Amicus Attorney Exchange Direction QuickBooks  

Files AND Clients on File  Customer:Jobs 

File Types  Job Types 

Contacts in the “Vendors” 
Group 

 Vendors 

Time Entries  Time Entries 

Billing Rates  Service Items 

Activity Codes  Service Items 

Location OR Timekeeper 
OR File Type OR Billing 
Category based on 
Preference setting 

 Classes 

In some instances the above noted records are filtered based on 
certain criteria such as their current status (i.e., Active v. Inactive). 
The following rules apply: 

Files/Jobs: 

• Only Amicus Attorney Active Files with an associated Client where 
the Responsible Lawyer is mapped to a QuickBooks Sales Rep will 
be exchanged. 

• Only QuickBooks Active Jobs where the Sales Rep is mapped to an 
Amicus Attorney Timekeeper will be exchanged. 

• Updates will not be sent over from Amicus Attorney where the 
Amicus Attorney File is Active and the QuickBooks Job is Inactive. 
Therefore, changes must be manually input. 

• Updates will be sent over from QuickBooks to Amicus Attorney 
where the QuickBooks Job is Active and the Amicus Attorney File is 
Closed.  
Note: The Amicus Attorney File Status will not change from Closed 
to Active. 

• Updates to some fields are not supported in QuickBooks. See Field 
Mapping for details. 

Vendors: 

• Only QuickBooks Vendors marked “Active” will be exchanged. 

• Only Amicus Attorney Vendors belonging to the “Vendors” Contact 
Group will be exchanged. 

File Types/Job Types: 

• Only QuickBooks Job Types marked “Active” will be exchanged. 

• Updates are not supported. 
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Activities/Services Items: 

• Activities that do not exist as Service Items in QuickBooks will be 
added. 

• Any Service Item that matches an Activity will not be updated, as 
this function is not supported in QuickBooks. Therefore, changes 
must be manually input. 

Billing Rates/Service Items 

• Billing Rates that do not exist as Service Items in QuickBooks will 
be added. 

• A “parent” Service Item for the Amicus Attorney Timekeeper will be 
created in QuickBooks, with “Subitems” created for each Billing 
Rate. 

• Any Service Item that matches a Billing Rate will not be updated, 
as this function is not supported in QuickBooks. Therefore, changes 
must be manually input. 

Classes: 

• Selected record type information (Location or Timekeeper or File 
Type or Billing Category) that does not exist in QuickBooks will be 
added. 

• Updates are not supported. 

Time Entries: 

• Selected Time Entries are posted from Amicus Attorney to 
QuickBooks from the Team Member Workstations. 

• Updates to Time Entries already posted to QuickBooks are not 
supported. Revisions must be made directly in QuickBooks. 

What is Mapped but not Exchanged? 

The following record types are mapped through Amicus Attorney 
rather than exchanged:  

Amicus Attorney QuickBooks  

Team Members * Employee List 

Responsible Lawyer Rep List 

Preference setting Accounts: 

Fee Income  

Preference setting Company File 

* Team Member mapping requires that values already exist in both applications. 

Mapping facilitates differences in naming conventions.  

Important: All QuickBooks Employees mapped to Amicus Attorney 
Team Members must also appear in the Sales Rep List in QuickBooks. 
For details, please see the section, Assigning QuickBooks Sales Reps to 
Customers, later in this document. 
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About Files/Clients and Customers/Jobs 
A Customer in QuickBooks is the equivalent of a Client on an Amicus 
Attorney File, and a Job in QuickBooks is the equivalent of an Amicus 
Attorney File. These records are exchanged in both directions.  

New Files opened in Amicus Attorney are created in QuickBooks, and 
vice versa. An Exchange also handles updates to Files/Clients already 
Exchanged with Customer:Jobs. Note that following Initialization, any 
new and changed Files and Client information are always sent first 
from Amicus Attorney; then new and changed Customer:Jobs are sent 
from QuickBooks.  

Not all Files and Customer:Jobs are included in the Exchange. For 
details, see the section, What is Exchanged? For details on how fields 
are mapped during the Exchange and which fields are updated, see 
the section, Field Mapping.  

Record deletions are not supported in the link. Deletions must be done 
manually in both applications. 

Amicus Attorney Files/Clients 
During Initialization, your Amicus Attorney Files will be updated to 
include a QuickBooks Client Information field in place of the Other field 
on the Client & Matter brad. On existing Files, this field will be 
automatically populated with the Contact information for the Client 
assigned to the File. (If there is more than one Client assigned to the 
File, the first Client will be used, but can be changed manually through 
the QuickBooks Client Information dialog.) This is the Client data that 
will be exchanged with your QuickBooks Customer information. The 
actual Amicus Attorney Contact card for this Client is not updated 
unless you choose to do so on an individual basis through the 
QuickBooks Client Information dialog. Assigning a Client to a new File 
created in Amicus Attorney will also cause this field to be populated 
with Client information.  

 

New Files created during the Exchange will assign the QuickBooks Rep 
as the Responsible Lawyer, and also assign that Responsible Lawyer’s 
default Team Members on new Files in accordance with their own 
Preference setting.  
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About the QuickBooks Client Information dialog 

In the Client Information dialog, Client Information can be entered 
manually or may be modified: 

• During Initialization for all new and existing Files. 

• During an Exchange when new Files are sent over from QuickBooks 
or existing Client information is updated. 

• When new Files are opened in Amicus Attorney. 

The Client information is Exchanged directly with the corresponding 
QuickBooks Customer:Job record. The actual Amicus Attorney Contact 
card for this Client is not updated unless you choose to do so on an 
individual basis through the QuickBooks Client Information dialog. See 
the section below, Updating Client/Contact Information. 

From the Client Information dialog you may select another Client on 
the File to be exchanged with QuickBooks, create a new Amicus 
Attorney Client/Contact based on the existing Client information, and 
update the existing Amicus Attorney Client/Contact information.  

 

 To access the QuickBooks Client Information dialog: 

1 

2 

3 

From the Amicus Attorney File, select the Client & Matter brad. 

From the QuickBooks Client Information field, click the Edit Client 
button. 

The QuickBooks Client Information dialog appears. See the topics 
below for information on selecting, creating, or updating a 
Client/Contact.  

Any changes made to the QuickBooks Client Information dialog will be 
reflected in the Address Information tab of corresponding QuickBooks 
Job record the next time information is Exchanged. 

Selecting another Client  

If another Client is assigned to the same File, you may select that 
Client’s information to replace the existing Client Information that is 
Exchanged with QuickBooks.  
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 To select another Client on the File to be Exchanged with 
QuickBooks: 
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1 From the QuickBooks Client Information dialog, click the Select from 
List button.  

The following prompt appears: 

 

2 Click OK to continue. 

The Select a Contact dialog appears. 

 

3 

4 

Choose the Client whose name and contact information you wish to 
Exchange with QuickBooks, and click OK.  

From the QuickBooks Client Information dialog, click OK. 

The selected Contact information is assigned to the QuickBooks Client 
Information field. 

 

The next time you Exchange information through Amicus 
Administrator, the Client you have selected will replace the Customer 
information in the Address Information tab of the corresponding 
QuickBooks Job record. Please note that the QuickBooks parent 
Customer record will not be updated.  
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Creating a New Amicus Attorney Contact based on the Client 
Information 

Because the Exchange of Client data only occurs between the Client 
Information field and QuickBooks, you may wish to add the Client to 
the File, and create a new Amicus Attorney Contact (if required) from 
the Client Information dialog.  

 To create a new Amicus Attorney Contact and assign the 
Contact as a Client on the File based on the information in the 
Client Information dialog: 
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1 

2 

1 

2 

3 

Click the Create New Client button. 

The following occurs: 

• Amicus Attorney runs a check to ensure that a duplicate Contact 
does not already exist. 

• All Team Members assigned to the File are automatically assigned 
to the Contact. 

• The Contact is assigned to the “Client” Contact Group. 

• The primary Contact card is set according to whether the Client is 
an Individual or Corporation (i.e., if the Client is an Individual, the 
Home card is set; if the Client is a Corporation, the Office card is 
set).  

• “Client” is chosen as the File association (i.e., “On this File this 
Person is a: Client”), and the Client is specified as an Individual or 
Corporation on the File. 

Click OK in the QuickBooks Client Information dialog.  

Updating Client/Contact Information 

Any updates made to the Client Information dialog are not 
automatically reflected in the matching Amicus Attorney Contact 
record.  

 To update your Client/Contact information in Amicus Attorney: 

Click the Update Existing Client button.  

You are prompted that this Contact exists and asked whether you wish 
to update this Contact. Click Yes. 

Click OK in the QuickBooks Client Information dialog. 

QuickBooks Customers/Jobs 
Although QuickBooks allows you to enter Matter (Job) information in 
your Customer record, the link will not support this configuration. All 
Matter information must be separated from your Client (Customer). 
For further details, see the section, Moving Jobs out of the Customer 
Records. 
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The naming convention you have chosen for your Customer:Jobs in 
QuickBooks will affect field mapping and should be taken into account 
when checking data consistency. You may have chosen to identify your 
Customer:Jobs by Client ID and Matter ID, or by Client Name and 
Matter Name. For more details, see the following section, 
Customer:Job Naming Conventions. It is important that your General 
option settings properly reflect your naming convention.  

In Amicus Attorney, Clients can be designated as an “Individual” or a 
“Corporate” entity on the File. In order to handle this designation in 
QuickBooks, these values are added to the Customer Type List during 
Initialization. 

Note on Customer:Job Addresses: If you experience problems 
related to exchanging address information, you will need to open the 
QuickBooks Customer:Job record, and ensure that the address 
information items (i.e., Address, City, State/Province, Zip/Postal Code) 
reside in their proper fields in the Edit Address Information dialog. See 
the Troubleshooting section later in this document for details on 
verifying your address information in QuickBooks. 

Customer:Job Naming Conventions 

Field assignments for exchanging Files are dependent on whether you 
identify your Customer:Jobs according to Client ID:Matter ID or Client 
Name:Matter Name. It is important that your General option settings 
properly reflect the naming convention you use in QuickBooks, and 
that all records use the same naming convention. 

Important: You must ensure that Jobs are separate records and not 
part of the Customer parent record. For information, see the section, 
Moving Jobs out of the Customer Records. 

Using the Client Name:Matter Name Convention 

If you choose to identify Customer:Jobs according to Client 
Name:Matter Name, the Full Client Name and the Full Matter Name in 
the Amicus Attorney Client & Matter brad will be used to identify the 
Customer and Job in QuickBooks.  

For example, the following illustrates an Amicus Attorney File with  
“Clark Admiral” assigned as the Full Client Name and “Widgetco 
Purchase” assigned as the Full Matter Name:  
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Upon Exchange, “Clark Admiral” will be created as the corresponding 
QuickBooks Customer and “Widgetco Purchase” will be created as the 
corresponding QuickBooks Job: 

 

During Initialization, matches will be identified based on the Amicus 
Attorney Full Client Name and Full Matter Name compared with the 
QuickBooks Customer:Job Name. 

Note: If the Full Client Name field is empty in Amicus Attorney, then 
the first Contact designated as a Client on the File will be assigned. (If 
the Client is a corporation then the Company Name will be assigned; if 
the Client is an individual, then the First, Middle, and Last Name will 
be assigned.) If the Full Matter Name field is empty in Amicus 
Attorney, then the Short File Name will be assigned.  

Using Client ID:Matter ID Convention 

If you choose to identify Customer:Jobs according to Client ID:Matter 
ID, the Client ID and Matter ID in the Accounting brad of your Amicus 
Attorney File will be used to identify the Customer and Job in 
QuickBooks.  

For example, the following illustrates an Amicus Attorney File with a 
Client ID of “10215” and a Matter ID of “11212”: 

 

Upon Exchange, “10215” will identify the corresponding QuickBooks 
Customer and “11212” will identify the corresponding QuickBooks Job: 

 

About File Types 
File Types in Amicus Attorney are exchanged bi-directionally with Job 
Types in QuickBooks. File Types can also be used to track Classes. 

File Types in Amicus Attorney are created in a simple one-level list, 
whereas, QuickBooks supports multiple levels of Job Types.  

For example, in QuickBooks you could have a multi-level Job Type of 
Real Estate with a subitem of Residential with a further subitem of 
Condominium. This would be displayed in QuickBooks lists as follows: 
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Upon Initialization or Exchange, this QuickBooks Job Type would be 
created in Amicus Attorney with the name “Real Estate:Residential: 
Condominium”. It is highly recommended that multi-level File/Job 
Types be originated from QuickBooks in order ensure that hierarchical 
parent records are properly identified. See the Important Note in the 
section, Using QuickBooks Classes, regarding hierarchical records if 
File Types are tracked under Classes. 

It is important to remember that File Types in Amicus Attorney 
determine the custom fields that will be available on the File. Changing 
a File Type should be done with caution.  

Not all File Types and Job Types are included in the Exchange. For 
details, see the section, What is Exchanged? For details on how fields 
are mapped during the Exchange and which fields are updated, see 
the section, Field Mapping. 

Deletions and updates to File Types are not supported in the link. 
Changes and deletions must be done manually in both applications. 

About Vendors 
When you are configuring your Exchange options, you may select an 
option that will enable you to bi-directionally exchange QuickBooks 
Vendors with Amicus Attorney Contacts who have been assigned to a 
Contact Group containing the word “Vendors”. All Contacts who are 
designated as Vendors in Amicus Attorney will be exchanged with 
Vendors on the QuickBooks Vendor list.  

Not all Vendors are included in the Exchange. For details, see the 
section, What is Exchanged? For details on how fields are mapped 
during the Exchange and which fields are updated, see the following 
Field Mapping section.  

Record deletions are not supported in the link. Deletions must be done 
manually in both applications. 

Important: The QuickBooks Vendor name should always match the 
QuickBooks Company Name and/or First/Last Name. This will ensure 
that duplicates are not created when you Exchange information. 

About Team Member Assignments 
When Exchanging information with QuickBooks, Team Members are 
assigned to the following records in Amicus Attorney: 

• New Files 

• New Contact records for Clients on Files 

• New Contact records for Vendors 
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How Team Members are assigned to a new Amicus Attorney File 
created from an Exchange is dependent on the Responsible Lawyer 
assignment for that File: When you create a new Customer:Job in 
QuickBooks and Exchange information with Amicus Attorney, the 
QuickBooks Rep assigned to the Customer:Job will become the 
Responsible Lawyer on the new File created in Amicus Attorney. Those 
whom the Responsible Lawyer has chosen to be assigned by default in 
his or her Preferences will determine the Team Members assigned to 
the new File. For example, if Heather Gavel has pre-assigned Bobby 
Donnell and Elaine Wassal to be the default Team Members on new 
Files in her Preference settings, they will be automatically assigned to 
all new Files created upon an Exchange for which she is the 
Rep/Responsible Lawyer.  

Customers in QuickBooks are the equivalent of Clients on Amicus 
Attorney Files. Therefore, when a File is created in Amicus Attorney 
upon Exchanging information, the Customer for the Job in QuickBooks 
becomes the Client on the File in Amicus Attorney. Team Members on 
a File are automatically assigned to the Contact records for all parties 
on the File. For example, if the Team Member Bobby Donnell is 
assigned by default to a File that has Matthew Alladin added as a 
Client on the File, Bobby Donnell will be also be assigned to Matthew 
Alladin’s Contact record.  

If you selected the option for exchanging QuickBooks Vendors with 
Amicus Attorney Contacts who have been assigned to the “Vendors” 
Contact Group when you configured your Exchange options, ALL 
Amicus Attorney Team Members will automatically be assigned to 
Vendor Contacts created upon an Exchange. 

About Time Entries 
Time Entries in Amicus Attorney are exchanged with QuickBooks in 
one direction - from Amicus Attorney to QuickBooks. Time Entries, 
unlike other data exchanged with QuickBooks, are sent through the 
Posting function in the Time Sheets module at each individual 
workstation and not through the Exchange function in Amicus 
Administrator. This model will maintain the law firm workflow within 
which lawyers are accustomed to working. It allows the lawyer to be 
confident that the Time Entries will not be billed until they are 
finalized.  

Both Billing Rates and Activities are exchanged in one direction from 
Amicus Attorney to QuickBooks Service Items. This ensures that the 
proper Rate is applied to Time Entries posted to QuickBooks from 
Amicus Attorney under various scenarios: 

• The Service Item for the Timekeeper’s Billing Rate specified in the 
Time Entry will be applied and the duration is Exchanged.  

• Non-billable Time Entries can be sent from Amicus Attorney to 
QuickBooks. They will be created in QuickBooks with reference to 
the Timekeeper’s Non-Billable Service Item and with the Billable 
checkbox unchecked and the duration is Exchanged.  
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• If the Timekeeper’s Billing Rate is a Contingency Rate, then a Non-
billable Contingency Service Item is applied in QuickBooks, and the 
duration is Exchanged. 

• If the Amicus Attorney Time Entry’s Billing Rate is a Flat Rate, then 
a search is performed for a corresponding Service Item upon 
Exchange. If no corresponding Service Item exists for the Flat 
Rate, then a Service Item is created with the name “Flat Rate - 
[value]”, and the duration is set at 1 hour.  

• If the Amicus Attorney Time Entry’s Billing Rate is an Other Rate, 
then a search is performed for a corresponding Service Item upon 
Exchange. If no corresponding Service Item exists for the Other 
Rate, then a Service Item is created with the name “Other Rate - 
[value]”, and the duration is Exchanged. 

About Billing Rates and Service Items 
Billing Rates in the link are exchanged in one direction only - from 
Amicus Attorney to QuickBooks Service Items. This is to ensure that 
any Billing Rate used in an Amicus Attorney Time Entry will exist as a 
Service Item in QuickBooks. A Service Item parent record will be 
created during Initialization or Exchange for each Timekeeper, if one 
does not already exist, with Subitems for each Billing Rate, including 
Non-billable and Contingency. For example, the Amicus Attorney 
Timekeeper, “Heather Gavel”, is matched with the QuickBooks Service 
Item (parent item) of the same name*, and the Amicus Attorney 
Billing Rates belonging to that Timekeeper for each Billing Category 
(i.e., “Normal”, “Discount”, etc.) are matched with the QuickBooks 
Subitems of the same names.  

The following illustrates how the Timekeeper and Billing Rates appear 
as a Service Item and Subitems, respectively, in the QuickBooks Item 
List: 

 

* Please note that the Amicus Attorney Timekeeper is matched with 
the QuickBooks Service Item (parent item) according to the Mapped 
Name. No rate or description is required for the parent record. 

Important: Deletions and modifications to Billing Rates are NOT 
supported in the link. All modifications and deletions must be 
performed manually in both applications. 

About Activities and Service Items 
Non-billable Time Entries can be sent from Amicus Attorney to 
QuickBooks. This will allow QuickBooks users access to Amicus 
Attorney Activities through the QuickBooks database.  
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Amicus Attorney Activities can be created on multiple levels, and it is 
important to note that QuickBooks only supports up to five (5) levels 
of Service Items.  

A match will occur only if the Activity Name in Amicus Attorney and 
Group Name (or other subitem name, where applicable) matches the 
QuickBooks Service Item Name and the “Subitem of” the parent 
name(s), where applicable. For example, a new Activity of “Exchange 
Voice Mail” under the “Telephone” Activity Group in Amicus Attorney 
will be created in QuickBooks, only if the parent level “Telephone” 
already exists in QuickBooks.   

The best views for comparing your current records is through the 
QuickBooks List Window and the Configure > Time Sheets dialog in 
Amicus Administrator, or from a printout of the information from each 
program.  

Deletions and updates to Activities are not supported in the link. 
Changes and deletions must be done manually in both applications. 

The maximum number of allowable characters for the name of a 
QuickBooks Service Item is 31. If the name of an Amicus Attorney 
Activity exceeds this number, the Service Item will appear truncated in 
QuickBooks upon Initialization or Exchange, and may result in a non-
unique Service Item being sent over. All Service Item Names must be 
unique in QuickBooks. 

UTBMS Task and Activity Codes are currently not supported.    

Using QuickBooks Classes 
Those users who take advantage of Classes in QuickBooks for 
purposes of tracking different segments of their business and breaking 
down income and expenses for each segment, can carry that tracking 
ability through to Time Entries that are posted from Amicus Attorney. 
This will ensure a more accurate analysis of your business practices. 
Classes should only be used for tracking one area. 

If you intend to activate the Amicus Attorney option for tracking 
Classes when you are configuring your General option settings, Class 
tracking must first be enabled in QuickBooks.  

You have the choice in your Setup options of tracking one of four 
areas: 

 Location  
 Timekeeper 
 File Type 
 Billing Category 

This option will cause your selected data type to populate the Class 
field of all Time Entries sent from Amicus Attorney to QuickBooks. For 
example, if you chose Fee Methods, then the Billing Category for the 
Time Entry would be included.  
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Each of these four types of Amicus Attorney records are created in a 
simple one-level list, whereas QuickBooks supports multiple levels of 
Classes. Therefore, any new Classes created in QuickBooks through 
the link will be added as non-hierarchical records.  

The exchange of Class List values will be one-way from Amicus 
Attorney to QuickBooks based on your General option settings. For 
more details on how fields are mapped, see the Field Mapping section. 

Deletions and updates to Classes are not supported in the link. 
Changes and deletions must be done manually in both applications.  

Important Note if Files Types are Chosen: Files Types are also 
exchanged in both directions with QuickBooks Job Types. If your Job 
Types are hierarchical, they will be added in Amicus Attorney with 
each subitem name separated by a colon (:). This character is not 
supported by QuickBooks in Class List Names, and therefore 
hierarchical Job Types are not supported if they are also to be used in 
Class Lists. 

In order for Classes to appear in your Time Entries, you need to 
open QuickBooks, select Edit > Preferences, choose Payroll & 
Employees, click the Company Preferences tab, and from the “Assign 
one Class per” option, activate the Earnings Item radio button. 

 

Field Mapping 

Amicus Attorney File/Client and QuickBooks 
Customer:Job  
Amicus Attorney File QuickBooks 

Customer:Job  
Fields 

Amicus Attorney 
Contact (applies only 
to new Contact created 
via link) 1 

Client ID:Matter ID  
or  
Client Name:Matter 
Name 2 

Customer:Job 
Name 
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Amicus Attorney File QuickBooks 
Customer:Job  
Fields 

Amicus Attorney 
Contact (applies only 
to new Contact created 
via link) 1 

Company Name 3  Company Name 4 Company Name  

Prefix 3 Salutation 4 Prefix 

First Name 3 First Name 4 First Name 

Middle Name 3 Middle Initial 4 Middle Name 

Last Name 3 Last Name 4 Last Name 

Address 3 Bill To Address 
(Street) 

Street Address  

City 3 Bill To Address 
(City) 

City  

State/Province 3 Bill To Address 
(State/Province) 

State/Province 

Zip/Postal Code 3 Bill To Address 
(Zip/Postal Code) 

Zip/Postal Code 

Phone 3 Phone Home Phone or  
Company Phone 

Alt. Phone 3 Alt. Phone Home 2 Phone or  
Business 2 Phone 

Fax 3 Fax Home Fax or  
Business Fax 

E-mail 3 E-mail Home E-mail or  
Business E-mail 

Client Role on File 6  Customer Type  
Reference 5 

 

Responsible Lawyer 6, 7  Rep   

File Status 6 Job Status  

File Open Date 6 Job Start Date   

File Status: “Active” 6 Active  

File Type 6 Job Type Reference  

1 –  This column only applies to new Contacts created in Amicus Attorney during 

Initialization or Exchange, and is dependent on the QuickBooks Customer Type. If 

the Customer Type is Individual, then Address and Communication items will be 

assigned to the Home Card of the Amicus Attorney Contact. If the Customer Type is 

Corporate, then Address and Communication items will be assigned to the Office 

Card of the Amicus Attorney Contact. If the Customer Type has not been specified, 

or if it is neither Individual nor Corporate, then the following rule applies: If the 

QuickBooks Company Name field is empty, Address and Communication items will 

be assigned to the Home Card of the Amicus Attorney Contact. If a name has been 

entered in the QuickBooks Company Name field, Address and Communications items 

will be assigned to the Office card. Please note that Amicus Attorney Contact cards 

are not updated during an Exchange with QuickBooks. Only the Client Information 

on the File is changed.  

2 – Dependent on whether QuickBooks Customer:Jobs are set to be identified as Client 

ID:Matter ID or Client Name:Matter Name in your General options. 

3 – These fields appear in QuickBooks Client Information field on Client & Matter brad of 

Amicus Attorney File.  

4 – When Exchanging data from Amicus Attorney to QuickBooks, Name information is 

assigned to the Bill To Street Address field. 
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5 – Refers to entity designation: Individual or Company. 

6 – Not updated on change. 

7 –  Based on Team Member Mapping. See also: About Team Member Assignments. 

Amicus Attorney Contacts assigned to Vendors List and 
QuickBooks Vendors 

Note: The following table applies if the Setup option has been enabled 
for exchanging QuickBooks Vendors with Amicus Attorney Contacts 
who have been assigned to the Vendors Contact Group. 

Amicus Attorney 
Contact in Vendor 
Group 

QuickBooks 
Vendor  
 

Last/First/Middle Name 
and/or 
Company Name * 
 

Name  

Company Name (Office 
Card) 
 

Company Name 

Prefix 
 

Salutation 

First Name 
 

First Name 

Middle Name 
 

Middle Initial 

Last Name 
 

Last Name 

Office Address 
 

Vendor Address 

Business Phone 1 
 

Phone 

Business Phone 2 
 

Alt. Phone  

Business Fax 
 

Fax 

Business E-mail 
 

E-mail 

*  If both the Company Name and First/Last Name fields are empty in QuickBooks, the 

Vendor Name is assigned to the Company Name field in Amicus Attorney. 

Amicus Attorney Activities and QuickBooks Service Items 
Amicus Attorney 
Activity 

QuickBooks Service 
Item 

Activity Name Item Name/Number 
Activity Group Name (if 
applicable) 

Subitem of 

Activity Rate Attribute 
Description * 

Description 

Activity Rate (if 
applicable) 

Rate 

Fee Income Account 
Name  
(as per Preference) 

Account 

* This refers to the type of Rate associated with the Activity. 
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Amicus Attorney Billing Rates and QuickBooks Service 
Items 
Amicus Attorney 
Billing Rate 

QuickBooks Service 
Item 

Billing Rate Name Item Name/Number 
Timekeeper Subitem of 
 Description 
Billing Rate  Rate 
Fee Income Account 
Name  
(as per Preference) 

Account 

Before You Initialize 
It is highly recommended that you take the time to understand the 
fundamental ways in which data sharing with QuickBooks works. See 
the section, “What is Exchanged”. 

Before performing the Initialization, there are some preliminary 
procedures you will need to do. The following is a checklist of these 
steps, each of which are fully detailed in this document. 

1 

2 

3 

4 

5 

6 

7 

8 

9 

10 

11 

Ensure data consistency between Amicus Attorney and QuickBooks. 

In QuickBooks, assign QuickBooks Reps to every Customer whose Job 
information will be Exchanged with Amicus Attorney. 

In QuickBooks, move Jobs out of Customer records. 

In Amicus Attorney, select QuickBooks as your Accounting System.  

In Amicus Attorney, configure your Setup options in Amicus 
Administrator. 

In QuickBooks, configure your Integrated Application Preferences, if 
desired. For information, see the Recommendation in the topic, . 

Back up your data in QuickBooks. Note: Backing up Amicus Attorney 
data is done automatically when you perform the Initialization. 

In Amicus Attorney, perform the Initialization. 

Configure individual Team workstations so that Team Members may 
access the QuickBooks Company File. 

From the QuickBooks.txt log file, resolve any inconsistencies listed. 

Once you have Initialized, you may Post Time Entries from Amicus 
Attorney to QuickBooks and Exchange information on a regular basis 
to ensure data is kept up-to-date. 

Note: If you encounter difficulties while sharing data with QuickBooks, 
please consult the topics contained in the “Troubleshooting” section of 
this white paper.  

Backing up your Data in QuickBooks 
Before you set up the link, it is strongly recommended that you back 
up your data in QuickBooks before Initialization. For instructions, 
consult your QuickBooks documentation.  

Note: There is no need to back up your Amicus Attorney data as this 
is done automatically when you perform the Initialization. 
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Ensuring Data Consistency 
It is highly recommended that a data review be carried out prior to 
Initialization to ensure that data has been consistently entered in key 
fields in both applications. It is equally important that all Team 
Members understand the basics of how Amicus Attorney and 
QuickBooks match data based on the key fields and how the subitems 
within each of the applications affect the match criteria. The most 
basic underlying premise of the link is that if a match is not found in 
the other application, the record will be added. Therefore, data 
consistency is especially important for those types of records that are 
exchanged in both directions. Taking the time to check for data 
consistencies and making those Team Members who enter data aware 
of the link fundamentals, will help in eliminating duplicates from being 
created upon Initialization and subsequent Exchanges. 

Assigning QuickBooks Reps to Customers 
QuickBooks Employees specified as Reps on Customer records are the 
equivalent of Amicus Attorney Team Members assigned as Responsible 
Lawyers on Files. In order to assign a Rep to a Customer record, you 
must first set up the Employee as a Sales Rep.  

There must be a Sales Rep who is mapped to an Amicus Attorney 
Team Member assigned to every Customer whose Job information is to 
be exchanged with Amicus Attorney. 

 To add a Rep to a Customer in QuickBooks: 
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1 From the Customer:Job List, double click on a Customer record to 
open it.  

 

2 From the Edit Customer window, click the Additional Info tab. 

 

3 Click the Rep drop-down, and select the Employee whom you wish to 
add as a Rep to the Customer. 

Last Modified: May 2005 

Lori Berenson
Highlight



 
 

 

4 

1 

Click OK to save the Customer record. 

If your Employees have not been assigned to the Sales Rep List you 
will need to add them. 

 To add QuickBooks Employees to the Sales Rep List: 

From the Lists menu, choose Customer & Vendor Profile Lists, and 
then choose Sales Rep List. 
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2 Click the Sales Rep button and select New. 

 

3 From the Sales Rep Name field, click the drop-down, select an 
Employee name, and click Next.  

 

4 After selecting the last Employee to be added as a Sales Rep, click OK.  

All QuickBooks Employees added to the Sales Rep List may now be 
added to Customer records. 

Moving Customer Jobs out of Customer Records 
Jobs in QuickBooks cannot reside at the Customer record level, as 
QuickBooks does not support the addition of new Jobs to this type of 
Customer. All Jobs must appear listed beneath the Customer record in 
the Customer:Job List.  

Before you Initialize the link, it is important that you manually 
separate Jobs from their respective Customer records in QuickBooks. 
If the link has already been Initialized, ensure that any newly added 
Jobs that reside at the Customer record level are separated before you 
exchange information.  
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 To manually separate a Job from the Customer level and place 
it into the Jobs category: 
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1 From the Customer:Job List in QuickBooks, highlight the Customer 
record in which Job information exists at the Customer level. 

 

2 Select Customer:Job > Add Job. 

 

The following prompt appears: 

  

3 

4 

Click OK. 

A New Job window appears. Click Cancel. 

Last Modified: May 2005 



 
 

 
Amicus Attorney V: Designed for use with QuickBooks © 2005 Gavel & Gown Software Inc.  23 

5 

6 

The Job information now appears in the Customer:Job List category 
below the Customer record displaying the default title, “Job 1”. Note: 
If you open the Customer record, you will see that there is no Job Info 
tab. 

To edit the name of the Job record, double-click on the record to open 
it.  

 

7 From the Edit Job window, enter an appropriate name of the Job in the 
Job Name field.  

 

8 Click OK to save your Job information. 

The proper Job name appears listed under the Customer record in the 
Customer:Job List. 

 

Last Modified: May 2005 



 
 

Selecting QuickBooks as your Accounting System and 
Configuring Setup Options 

Important: Before you select QuickBooks as your accounting system, 
please ensure that QuickBooks is running. 

 To select QuickBooks as your accounting system: 
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1 From Amicus Administrator, select Configure > Time Sheets. 

 

2 

3 

4 

5 

From the Time Sheets dialog, click the Accounting System tab. 

From the drop-down, select QuickBooks Link. 

 To configure your setup options: 

Click the Team Settings button to configure your settings.  

The QuickBooks link setup dialog appears. It consists of three tabs: 
General, Exchange, and Team Member Mapping.  

The QuickBooks link setup dialog opens to the General tab. 

 

From the General tab you will need to specify the following options: 

• Whether you wish to identify Customer:Jobs in QuickBooks as 
Client ID:Matter ID or Client Name:Matter Name. This is dependent 
on whether you use numbers or names for Customer:Jobs in 
QuickBooks. For information, see the section, Customer:Job 
Naming Conventions.  

• Whether you use QuickBooks Classes to track Separate Office 
Locations, Timekeepers, Types of Law, or Fee Methods. 
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Note: If you wish to use QuickBooks Classes for tracking purposes, 
please ensure that Class Tracking has been enabled in QuickBooks. 
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• 

6 

What Account Name you use for Fee Income. 

Click the Exchange tab. 

 

From the Exchange tab you will need to specify the following: 

• Which application you wish to have overwrite the other during 
Initialization: Amicus Attorney or QuickBooks. It is recommended 
that you select the application with the most up-to-date 
information.  

Note: After Initialization, Amicus Attorney will always overwrite 
the matching data in QuickBooks. 

• The full path name of the QuickBooks Company File (e.g., 
C:\Program Files\Intuit\QuickBooks\Amicus Attorney.qbw) 

• 

7 

Whether you wish to exchange QuickBooks Vendors with Amicus 
Attorney Contacts belonging to a Contact Group containing the 
word “Vendors”. 

Click the Team Member Mapping tab. This tab will dynamically list all 
Team Members in Amicus Attorney and all Employees in QuickBooks. 
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8 The first time you access QuickBooks, you will receive the QuickBooks 
- Application Certificate dialog, allowing you to access the Company 
File by clicking “Yes, This Time” or “Yes, Always”. (For details on 
accessing the QuickBooks Company File, see the following section.) 

 

9 

• 

10 

11 

Map your Amicus Attorney Team Members to your QuickBooks 
Employees from the Team Member Mapping tab.  

The Team Member Mapping tab in the QuickBooks link setup dialog 
contains two columns: one that lists your Amicus Attorney Team 
Members and one listing your QuickBooks Employees. You may map 
your Team Members/Employees in two ways:  

• By selecting a Team Member name in the left column, selecting the 
corresponding name in the QuickBooks Employees column, and 
clicking Map. 

By clicking Auto-Map to automatically map Team Members to 
matching Employees. 

If not all Timekeepers are mapped to a corresponding Employee, and 
you click OK in the QuickBooks link setup dialog, the following warning 
will appear: “One or more Amicus Attorney Timekeepers has not been 
mapped to a QuickBooks Employee.”  

Important: All Team Members mapped as QuickBooks Employees 
must also be set up as Sales Reps in QuickBooks. See the section, 
Assigning QuickBooks Reps to Customers. 

Once you have finished configuring your General and Exchange 
options and setting your Team Member Mapping, click OK. 

You will be reminded to perform a backup of your Amicus Attorney and 
QuickBooks systems before Initialization. Click OK. 

QuickBooks now appears as a separate menu item in the Amicus 
Administrator window. There are two menu options available: Initialize 
and Exchange. 

Before Initializing, you must first configure your settings. 
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Accessing the QuickBooks Company File 
The QuickBooks - Application Certificate dialog will appear in the 
following instances:  
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• 

• 

• 

• 

• 

By default when you are configuring your Setup options for the 
first time (specifically, the Team Member Mapping). 

If the “Yes, This Time” option is chosen, AND you click the Team 
Member Mapping tab, are posting a Time Entry, or are Exchanging 
Information. 

If the QuickBooks Administrator has specified for the prompt to 
appear through the Integrated Applications area of the QuickBooks 
Preferences, AND you click the Team Member Mapping tab, are 
posting a Time Entry, or Exchanging Information. 

You are presented with two options for allowing access to the 
QuickBooks Company File: 

You may click “Yes, This Time” to allow access to the QuickBooks 
Company File in the present instance and to be prompted each 
time the Company File is accessed through the link (i.e., when 
clicking the Team Member Mapping tab or posting a Time Entry). 

You may click “Yes, Always” to allow direct access to the 
QuickBooks Company File in every instance without the user being 
prompted. Note: This is the recommended setting. 

If you select the “Yes, Always” option, you are asked whether you are 
sure you want to allow access to the QuickBooks Company File without 
asking the user. You are also informed in this prompt that if you 
choose to continue, this setting may be changed back through the 
Integrated Applications area of your QuickBooks Preferences.  

Recommendation: The Integrated Applications area of the 
QuickBooks Preferences contains a setting for controlling access to 
QuickBooks from another application. It is recommended that the 
QuickBooks Administrator activate this setting to allow Amicus 
Attorney to access the QuickBooks Company File when QuickBooks is 
not running. (This is the recommended configuration for Initialization.) 
It may be set so that the QuickBooks - Application Certificate dialog 
will appear every time a Team Member tries to access the QuickBooks 
Company File, or it may be set so that access will be provided 
automatically.  

The QuickBooks Administrator may also de-activate this setting to 
disable the link, resulting in Timekeepers being unable to post Time 
Entries and Exchange data through Amicus Administrator. See your 
QuickBooks documentation for further information on the Integrated 
Applications area of your QuickBooks Preferences.  

Configuring Team Workstations 
All Time Entries posted by Team Members are sent directly to the 
QuickBooks Company File. Before Team Members may post Time 
Entries, they need to specify the location of this file from their 
individual workstations. 
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Note: The location of the QuickBooks Company File also needs to be 
entered at the Amicus Administrator level in the QuickBooks link setup 
dialog when you set your Exchange options. However, this setting is 
made specifically for the purposes of Initialization and Exchanging 
data, and not for posting Time Entries.  

To enter the location of the QuickBooks Company File from a Team 
Member workstation: 
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1 From Amicus Attorney, select File > Setup. 

 

2 

3 

From the Setup dialog, click the Billing tab.  

Click the Accounting Link tab. 

 

4 

5 

Click the Browse button to locate the QuickBooks Company File.  

Ensure that the same QuickBooks Company File is chosen as that 
which was selected during the setup in Amicus Administrator.  
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6 Click OK in the Setup dialog. 

You are now ready to initialize the link. 

Initialization 
Once you have configured your settings in Amicus Administrator, you 
are ready to initialize the link. Initialization ensures that both 
programs are synchronized with each other and duplications of 
Files/Clients and Customers/Jobs are avoided.  
The Team Administrator has the option of selecting which application 
data will be used in the event that records exist on both sides of the 
link. It is recommended that you select the program in which the data 
is the most up-to-date.   

On Exchanges done subsequent to Initialization, Amicus Attorney data 
will overwrite matching data in QuickBooks. 

The Initialization routine will perform the following: 

• Employ all of the preferences you have indicated in the QuickBooks 
link setup dialog, and ensure that all Team Members/Employees 
have been mapped.  

• Create new Matter/Client and Customer/Job records in Amicus 
Attorney and QuickBooks where necessary. 

• Align and link existing Matter/Client and Customer/Job records 
where a match occurs.  

• If the Team Administrator indicates by preference to Exchange 
QuickBooks Vendors with Amicus Attorney Contacts belonging to 
the Vendors Contacts Group: 

o New Vendor records will be created on both sides of the link. 

o Existing Vendor records will be aligned on both sides of the link 
where a match occurs. 

• Align Amicus Attorney File Types with QuickBooks Job Types. 

• Add Amicus Attorney Activities to QuickBooks as Service Items, if 
required.  

• Add Amicus Attorney Billing Rates to QuickBooks as Service Items, 
if required, with a Service Item parent record created for each 
Timekeeper. 

• Align Class Lists in QuickBooks according to your General Option 
Settings in Amicus Attorney.  
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Tip for first-time installs: If you are installing Amicus Attorney for 
the first time and have installed Amicus Administrator, but have not 
yet installed your Team Members, it is recommended that you add 
your Team Members through Amicus Administrator and Initialize the 
link prior to installing Amicus Attorney Team Member Offices. Running 
the Initialization prior to installing your Team Members will ensure that 
all new records are added. This will alleviate the processing of each 
individual transaction upon the Team Member opening their Office.  

 To perform Initialization:  

Note: Before Initializing, ensure that all Team Members are logged out 
of Amicus Attorney and are running online by selecting Users > User 
Management > Status from Amicus Administrator.  

For performance reasons, it is recommended that you DO NOT have 
QuickBooks running during Initialization, as this will result in slower 
processing of the data. However, in order to run Initialization in this 
configuration, you must first grant access to the Company File through 
your QuickBooks Integrated Applications Company Preferences.  

You must be running QuickBooks in Single-User mode to change your 
Integrated Applications Company Preferences (see your QuickBooks 
documentation for details).  

This also applies if you wish to have QuickBooks running during 
Initialization. If you prefer to have QuickBooks open during 
Initialization, you should be running QuickBooks in Single-User mode. 
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1 From the Amicus Administrator QuickBooks menu, select Initialize. 

 

A prompt appears informing you that the Initialization process will 
automatically back up your Amicus Attorney data, and that it is highly 
recommended that you first back up your data in QuickBooks prior to 
proceeding with the Initialization. 

2 If you have already backed up your data in QuickBooks, click OK to 
proceed with the Initialization. If you have not, click Cancel, back up 
your data in QuickBooks, and return to Step 1 of these instructions.  

The Initialization process begins.  

A message appears informing you that the Initialization process is 
complete, and that any discrepancies that may have been encountered 
during Initialization have been logged in the QuickBooks.txt log file.  
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3 Click OK to access the QuickBooks.txt log file, and resolve any 
inconsistencies listed. For information, see the Troubleshooting section 
later in this document for resolving inconsistencies using the 
QuickBooks.txt Log file. 

 

If you experience problems related to exchanging address information, 
you will need to verify your address information in QuickBooks. See 
the Troubleshooting section later in this document for details.  

Note: If you want to reference the QuickBooks.txt file at a later time, 
you may access it from the following location on the server: [drive 
letter]:\Program Files\Team50\Localdb folder. Please note that the 
QuickBooks.txt log file will be overwritten on subsequent Exchanges. 

Once the Initialization process is complete, the Exchange menu option 
will become active and you may begin Exchanging data. 

 

Warning: Once you initialize the link for the first time, subsequent 
selections of the QuickBooks > Initialize menu option will result in a 
dialog warning you that you have already initialized the link and that 
selecting this option again will reset the link. Re-Initialization is done 
when Amicus Attorney and QuickBooks records become out-of-sync, or 
after the database has been restored. 
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Exchanging Data 
The QuickBooks Exchange menu option is enabled after you have 
Initialized the link. The Team Administrator performs the process of 
Exchanging data between Amicus Attorney and QuickBooks on a 
regular basis, ensuring that information is kept up-to-date on both 
sides of the link.  

Records that are locked as a result of a Team Member accessing a 
record will not be included in the Exchange.  

Note: It is not necessary for Team Members to be logged out of 
Amicus during an Exchange—if any relevant Files or People are locked 
(in use), those particular records will be skipped at this time and dealt 
with on a subsequent Exchange. For recommendations on user access 
to QuickBooks during an Exchange, please consult your QuickBooks 
documentation.  

 To exchange data between Amicus Attorney and QuickBooks: 
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1 From Amicus Administrator, select QuickBooks > Exchange. 

 

2 If the QuickBooks - Application Certificate dialog appears, allow access 
to the file by clicking “Yes, This Time” or “Yes, Always”. (For details, 
see the section, Accessing the QuickBooks Company File, earlier in this 
document.) 

 

The Exchange of data begins. 

If you experience problems related to exchanging address information, 
you will need to verify your address information in QuickBooks. See 
the Troubleshooting section later in this document for details.  

You may receive a message informing you that discrepancies or locked 
records were encountered during the Exchange, and that you will need 
to refer to the QuickBooks.txt log file to resolve them.  
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3 Click OK to access the QuickBooks.txt log file and resolve any 
inconsistencies listed. For information, see the Troubleshooting section 
later in this document for resolving inconsistencies using the 
QuickBooks.txt Log file. 

If you want to reference the QuickBooks.txt file at a later time, you 
may close it and access it from the [drive letter]:\Program Files\ 
Team50\Localdb folder on the server. Please note that the 
QuickBooks.txt log file is overwritten each time you Exchange 
information. 

The latest changes are now reflected in both databases.  

Posting Time Entries 
Team Members may post Time Entries to QuickBooks from their 
Amicus Attorney Office through the Time Sheets module, provided: 

• The Team Administrator has set up the link.  

• They have QuickBooks Pro or Premier Edition installed on their 
workstations. 

• They have specified the location of the QuickBooks Company File in 
their Team Member Settings.  

• The QuickBooks Administrator has provided access to the 
QuickBooks Company File in the Integrated Applications area of the 
QuickBooks Preferences. 

Direct posting from the Team Member workstation, as it is commonly 
referred, has some restrictions: 

• Posting will fail if a user attempts to post on a File that has been 
created in Amicus Attorney but not yet created in QuickBooks 
because the Team Administrator has not yet done an Exchange. 
The user may post at some later time, when the File has been 
created in QuickBooks after an Exchange from Amicus 
Administrator. 

• Users cannot post when offline. 

Non-Timekeepers cannot post Time Entries from their own Office. 
However, any Team Member with the correct password may open a 
Timekeeper’s Office in Amicus Attorney and create or post a Time 
Entry for that Timekeeper.  
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 To post Time Entries from Amicus Attorney to QuickBooks:  
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1 Open the Amicus Attorney Time Sheets module. 

 

2 

3 

4 

If you only wish to post selected Time Entries, highlight only those 
Time Entries prior to clicking Post, otherwise, click Post.  

If the QuickBooks - Application Certificate dialog appears, allow access 
to the file by clicking “Yes, This Time” or “Yes, Always”. (For details, 
see the section, Accessing the QuickBooks Company File.) 

You will be prompted whether you wish to post specific Time Entries or 
all Time Entries at once.  

 

• 

• 

If you wish to post all your Time Entries for that day, click All.  

If you wish to post only the Time Entries you have selected, click 
Selected. 

If the posting of Time Entries is successful, a prompt appears asking 
you if you would like to obtain a printout of the Time Entries you have 
posted.  

If the posting is unsuccessful, a message will appear indicating that 
not all your Time Entries were posted. Any unposted Time Entries will 
remain in your Time Sheets module. 

If system problems occur during a post routine, you may receive a 
message the next time you start Amicus Attorney.  
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Troubleshooting 
The following topics present information that will help you resolve any 
difficulties that you may encounter when using the QuickBooks link. 

Re-Initialization 
A Re-Initialization utility is available in Amicus Administrator. This 
utility should only be used in the event that records become out of 
synch, perhaps due to some major change that has occurred in either 
database. This may occur after restoring a backup, recovering the 
database, or performing an archive or de-archive of records in Amicus 
Attorney. The Re-Initialization utility will first strip out all QuickBooks 
List identifiers stored in Amicus Attorney records, and then run the 
Initialization routines. Note that this process may be lengthy 
depending on the size of the databases and the number of Team 
Members.  

Important Note: It is highly recommended that you DO NOT re-
initialize the link without the assistance of an Amicus Attorney Certified 
Consultant or a Gavel & Gown Technical Support Representative.  

To re-initialize the link: 
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1 From Amicus Administrator, select QuickBooks > Initialize. 

The following dialog appears:  

 

2 

3 

Click Continue. 

A second dialog appears that reads:  

 

4 Click Continue to proceed.  

Note: After re-initializing the link, you may need to resolve 
inconsistencies using the QuickBooks.txt log file. See the following 
section, Resolving Inconsistencies using the QuickBooks.txt Log File. 
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Resolving Inconsistencies using the QuickBooks.txt Log 
File 

After you have performed an Initialization of the link or an Exchange 
of data, you may receive a message stating that discrepancies 
encountered during the Initialization/Exchange process have been 
logged in the QuickBooks.txt log file. When you click OK to this 
message, the QuickBooks.txt log file appears. 

 

The QuickBooks.txt log file is saved by default to the following folder 
on the server:  

[drive letter]:\Program Files\Team50\Localdb 

Note: Each time you Exchange information, the QuickBooks.txt log file 
is overwritten. 

 To resolve any inconsistencies that occurred during the 
Initialization of the link or Exchange of data: 

1 

2 

With the QuickBooks.txt log file open in Notepad, select File > Print.  

In the QuickBooks.txt log file you will find a list of records containing 
various discrepancies that need to be addressed on both sides of the 
link. For example, an Amicus Attorney File may contain incomplete 
data and cannot be created as a Job in QuickBooks, or an Amicus 
Attorney File cannot be created from a QuickBooks Customer because 
no Job information for that Customer exists.  

Please also note that some information may refer to items that were 
altered upon Initializing/Exchanging information. For example, if the 
name of an Amicus Attorney Activity exceeds the maximum number of 
allowable characters (31) for the name of a Service Item in 
QuickBooks, the Service Item name will be truncated in QuickBooks.  

Take the necessary steps to resolve the record inconsistencies listed so 
that all data is aligned. This will require you to manually modify the 
discrepant information in Amicus Attorney and/or QuickBooks. 

Once you have resolved the inconsistencies, you may Exchange 
information to ensure that all data is properly aligned and up-to-date. 
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Verifying Address Information 
QuickBooks automatically assigns First, Middle, Last, and Company 
Names to the Street Address fields (line 1 and line 2, respectively) for 
purposes of creating a full Bill To Customer Address. To ensure 
consistency, the link will also automatically assign Name fields to the 
Street Address. It is important to note that changes or new address 
information brought over from QuickBooks to Amicus Attorney will 
result in an assignment of all data in the Street Address field, including 
names. 

The following example shows the Bill To Address format for a 
Customer who has both Company and First/Last Name information: 

 
Amicus Attorney V: Designed for use with QuickBooks © 2005 Gavel & Gown Software Inc.  37 

• 
• 
• 
• 
• 

First Name, Middle Initial, and Last Name (if applicable)  

Company Name (if applicable)  

Street Address 

City, State/Province, Zip/Postal Code 

Country 

If you are experiencing problems when exchanging address 
information, open the Edit Address Information dialog in the 
QuickBooks Customer:Job record, and ensure that the address 
information items (i.e., Address, City, State/Province, Zip/Postal Code, 
Country) reside in their proper fields.  

Tip: If a new Client/Contact or Vendor/Contact is created in Amicus 
Attorney, or if you update the Amicus Attorney Contact card from your 
Amicus Attorney QuickBooks Client Information field, you may want to 
edit the Street Address in the Primary Contact card to remove any 
names, as they may affect Document Assembly output. For 
information on updating your Client Information, please see the 
section, About the QuickBooks Client Information dialog. For 
information on changing Contact card information, consult the section, 
Changing Contact Details, in your Amicus Attorney Team Member 
online Help.  

Error messages 

Cannot add to QuickBooks due to same name used in 
another list 

When Exchanging information, you may receive an error message 
stating that the name is already being used in another QuickBooks list. 
Such an error message will resemble the following: 

“File [File name] has been ignored. It is assigned to Customer 
[Customer name], which cannot be added to QuickBooks because the 
same name is already used in the QuickBooks Entity Lists.” 

The following scenarios will cause such an error message to appear 
upon Exchanging information: 

• If an Amicus Attorney Contact assigned as a Client on a File is also 
a Timekeeper. 

• If an Amicus Attorney Contact assigned as a Client on a File also 
belongs to the Vendors Group. 
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• If a Timekeeper is also an Amicus Attorney Contact belonging to 
the Vendors Group.  

Although Amicus Attorney allows for the above scenarios, QuickBooks 
does not permit you to share names between the Employee, 
Customer, and Vendor Lists. For example, if you have entered a name 
in the QuickBooks Employee List, you cannot enter a duplicate name in 
the Customer List or Vendor List. It is recommended that the name be 
changed in some manner to differentiate it from the other (e.g., John 
R. Doe instead of John Doe).  

One or more Time Entries not posted to QuickBooks 

If you attempt to post a Time Entry from Amicus Attorney, and 
someone is currently editing a Time Entry for the same Customer:Job 
in QuickBooks, the following error message appears: 

“One or more Time Entries were not posted into QuickBooks. There is 
an error when saving a Time Tracking. QuickBooks error message: 
Records need to be locked before they can be modified.” 

Foreign characters not supported 
Please note that the Exchange of foreign characters (e.g., à, é, ñ, ö, ú, 
ý, ß) in text fields is not supported in the link. 

 

 

 

For further information, contact  

 

Gavel & Gown Software Inc. 

365 Bay Street, Suite 700 

Toronto, Ontario M5H 2V1 

Telephone:  1 (800) 472-2289 

 1 (416) 977-6633 

Fax: 1 (416) 977-2563 

www.amicusattorney.com 

info@amicusattorney.com
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